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1 Printer Environment Settings

When you are finished installing your printer using the ‘Setup Guide’, go on to set up its 
operating environment.

1.1 Supported Operating Environments

The printer can be used both as a local and a network printer. When used as a local printer, 
the printer is connected directly to a computer. Connect the printer to a network for use as 
a network printer.

Set all ports you want to use to [Enabled] on the control panel.

 Using the Printer as a Local Printer
When using the printer as a local printer, the printer and a computer can be connected using 
the following methods:

• USB connection: Connecting the printer and a computer using a USB cable. 
(default: [Enabled])

• Parallel connection: Connecting the printer and a computer using a parallel cable. To use 
this feature, the Parallel Port Kit (optional) must be installed. (default: 
[Disabled])

 Using the Printer as a Network Printer
When using the printer as a network printer, the printer can be set up in the following 
environments:

• LPD : Used when using TCP/IP protocol to enable direct communication 
between the printer and a computer. (default: [Enabled])

• Port9100 : Used when using a Port9100 port.
(default: [Enabled])

• NetWare® : Used when sharing and managing the printer using a NetWare server. 
(default: [Disabled])

Internet
IPP

Network Connection
NetWare/Windows Shared Printer

Network Connection
LPD/SMB/Port9100/EtherTalk/WSD*

Server

Local Connection
Parallel/USB

*: WSD stands for Web Services on Devices.
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• SMB : Used when printing using a Windows® network. 
(default: [Enabled])

• IPP : Used when printing via the Internet. 
(default: [Disabled])

• EtherTalk® : Used when printing from Macintosh. (default: [Disabled])

• WSD* : Can be used when printing from Windows Vista®, Windows® 7, 
Windows Server® 2008, or Windows Server® 2008 R2. (default: 
[Enabled])

*: WSD stands for Web Services on Devices.

 Supported Operating Systems and Operating Environments

Note
• The supported operating systems are subject to change without prior notice. Visit our web site for the 

latest information.

Refer to
• For information on how to print PostScript data, refer to the manual on the PostScript Driver Library CD-

ROM.

Connectivity Local Network

Port Name Parallel*1 USB*2 LPD NetWare SMB IPP
Port 
9100

Ether 
Talk

Bon-
jour WSD*3

Protocol - -
TCP/

IP
TCP/

IP
IPX/
SPX

Net 
BEUI

TCP/
IP

TCP/
IP

TCP/
IP

Apple 
Talk

TCP/
IP

TCP/
IP

Windows® 2000          ‐ ‐ ‐

Windows® XP      ‐    ‐ ‐ ‐

Windows Vista®      ‐    ‐ ‐ 

Windows® 7    ‐ ‐ ‐    ‐ ‐ 

Windows Server® 
2003

     ‐    ‐ ‐ ‐

Windows Server® 
2008

     ‐    ‐ ‐ 

Windows Server® 
2008 R2

   ‐ ‐ ‐    ‐ ‐ 

Mac OS 9.2.2 ‐  ‐ ‐ ‐ ‐ ‐ ‐ ‐  ‐ ‐

Mac OS X
10.3.9 - 10.4.6, 
10.4.8 - 10.4.11, 
10.5, 10.6

‐   ‐ ‐ ‐ ‐  ‐   ‐

*1: To use this feature, the Parallel Port Kit (optional) must be installed.

*2: The computer must be connected to the printer via a USB 2.0 port.

*3: WSD stands for Web Services on Devices.
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 OS and Available Print Drivers

OS Print Driver Note

Windows® 2000

Windows® XP

Windows Vista ®

Windows®  7

Windows Server® 2003

Windows Server® 2008

Windows Server®  2008 R2

PCL Print 
Driver

Installing the print driver is available from the Driver CD 
Kit CD-ROM.
Refer to the ‘CD-ROM Documentation (HTML)’ on the 
CD-ROM.

PostScript 
Print Driver

Installing the print driver is available from the PostScript 
Driver Library CD-ROM.
Refer to the manual on the PostScript Driver Library CD-
ROM for details.

Mac OS  
9.2.2
10.3.9-10.4.6, 
10.4.8-10.4.11, 
10.5-10.6

PostScript 
Print Driver

Installing the print driver is available from the PostScript 
Driver Library CD-ROM.
Refer to the manual on the PostScript Driver Library CD-
ROM for details.
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1.2 Connecting a cable

Connect the printer to your computer using an interface cable appropriate for your 
connection method.

An interface cable is not included with the printer. You must purchase it separately.

USB Connection

When using a USB connection, install the printer driver on the computer after connecting 
the cable. For the installation method, refer to “1.7 Installing a Print Driver” (P. 43) and 
"Manual (HTML Document)" on the CD-ROM disk of the driver CD kit. 

1. Connect the USB cable to the interface 
connector. 

2. Connect the other end of the USB cable to 
the computer. 

Network Connection

Use 1000BASE-T (When the optional Gigabit Ethernet Board Card is installed) or a straight-
type network cable that supports 100BASE-TX or 10BASE-T.

1. Switch off the printer's power. 

2.  Wind the network cable around the 
supplied ferrite core and close the ferrite 
core.

Note
• Do not wind the cable to tightly or it may break.

A connector to be 
connected to the printer

Ferrite core

Approx. 7cm
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3. Connect the network cable to the interface 
connector on the printer. 

Note
• The location of the connector differs depending on 

whether Gigabit Ethernet Board Card is installed or 
whether the standard configuration is used. Connect 
the appropriate connector for your environment.

• When the Gigabit Ethernet Board Card is installed, the 
connector for the standard configuration cannot be 
used. 

• The MAC address is the same as in the standard 
configuration when installing the Gigabit Ethernet 
Board Card. 

• LED1 on the Gigabit Ethernet Board Card lights up as 
follows according to the network environment 
connected. 
10BASE-T environment: Off
100BASE-TX environment: Lights in yellow
1000BASE-T environment: Lights in blue 

4. Connect the other end of the network cable 
into a network device such as a hub. 

5. Switch on the printer's power. 

Note
• The interface connecter for standard network cannot be used when the Gigabit Ethernet Board Card is 

installed to the printer.
• When installing both Gigabit Ethernet Board Card and Feature Enhance Kit, install the Feature Enhance 

Kit first.
• Message [Ready to print IP Address failed] may be displayed on the control panel. To erase this 

message, set to [STATIC] in [Network / Port] > [TCP/IP Settings] > [IPv4 Settings] > [Get IP Address] to 
specify IP address (Example: 192.168.1.100) or [Disabled] for each port other than the USB port in 
[Network / Port].

Refer to
• For setting method of IP address, refer to “1.4 Setting the Network Environment” (P. 33).
• For setting each port, refer to “1.5 Enabling Ports” (P. 37) “.

Standard configuration

Gigabit Ethernet Board Card
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Parallel Connection

When using a parallel connection, you must first install the optional Parallel Port and 
connector conversion cable. 

Important
• Parellel Port Kit  (optional) and Gigabit Ethernet Board Card (optional) cannot be installed at the same 

time.

.1. Switch the printer off.

2. Insert the connector conversion cable 
included with the optional Parallel Port into 
the interface connector on the printer. 

3. Connect the other end of the connector 
conversion cable to the connector on the 
parallel cable. Then secure it using the 
metal pieces on both sides of the 
connector. 

4. Plug the other end of the parallel cable into 
your computer.

5. Switch the printer on.

Important
• Parallel Port Kit (Optional) and Gigabit Ethernet Board Card cannot be installed concurrently. If the 

Parallel Port Kit (Optional) is installed, remove the card by reference to “ Removing the Parallel Port Kit 
(Optional)” (P. 344).
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1.3 Switching the Control Panel Display 
Language

Select one display language from among [English], [Korean], [Simp.Chinese], and 
[Trad.Chinese] for the control panel of the printer.

The following explains how to switch the control panel display language.

1. Press the <Printer Settings> button to 
display the menu screen.

2. Press the < > button until [Language] is 
displayed.

Note
• If you went past the desired item, return to the item by 

pressing the < > button.

3. Press either the < > or <OK> button to 
select. 
The language is displayed.

4. Press the < > button until the desired 
language is displayed. 

5. Press the <OK> button to confirm.

6. Press the <Printer Settings>  button to 
close the menu. 
The printer automatically restarts.
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1.4 Setting the Network Environment

This section explains how to install your printer in a TCP/IP environment. When installing 
the printer in a different environment, refer to the ‘CD-ROM Documentation (HTML)’ on the 
Driver CD Kit CD-ROM.

Note
• The printer can use an IPv6 address in an IPv6 network environment. For information on using IPv6 

addresses, refer to “Setting an IP Address (IPv6)” (P. 36).

Setting an IP Address (IPv4) 

To use TCP/IP protocol, you must configure an IP address for the printer.

By default, the printer is set to obtain its IP address (via the [Get IP Address] setting on the 
control panel) using [DHCP/Autonet]. Thus, when the printer is connected to a network that 
has a DHCP server, the printer automatically obtains its IP address from the server. 

Print the [Configuration Report] to see if the printer already has an IP address.

If the printer does not have an IP address, set [Get IP Address] to [STATIC] and configure 
the address.

Note
• For information on how to print the [Configuration Report], refer to “7.2 Printing Reports/Lists” (P. 260).
• The printer can also obtain its IP address by using a BOOTP or RARP server. If using a BOOTP or 

RARP server, set [Get IP Address] to [BOOTP] or [RARP].
• If using a DHCP server, the printer’s IP address may change without notice. Make sure to check the 

address periodically.

The following explains how to set up an IP address on the Control Panel. Depending on your 
network environment, your printer also needs a subnet mask and gateway address. Consult 
your network administrator for the settings required for your printer.

 To Set the IP Address

Important
• Addresses including IP address, subnet mask and gateway address depend on your network 

environment. Consult your network administrator for setting addresses.

1. On the control panel, press the <Printer 
Settings> button to display the menu 
screen. 

If an IP address is listed, 
skip the following procedure.

If an IP address is not listed, 
or if you want to change the 
current IP address, configure 
the setting using the 
following procedure.[■ To Set 

the IP address].

Settings

 LanguageEmulation
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2. Press the < > button until [Admin Menu] is 
displayed.

Note
• If you went past the desired item, return to the item by 

pressing the < > button.

3. Press the < >or <OK> button to select.
[Network / Port] is displayed.

Note
• If you pressed the < > or <OK> button on the wrong 

item, return to the previous screen by pressing the 
< > or the  <Back> button.

• To start over from the beginning, press the <Printer 
Settings> button.

4. Press the < > or <OK> button to select.
[LPD] is displayed.

Note
• [Parallel] appears only when the Parallel Port Kit 

(optional) is installed.

5. Press the < > button until [TCP/IP 
Settings] is displayed.

6. Press the < > or <OK> button to select.
[IP Mode] is displayed.

7. Press the < > button until [IPv4 Settings] 
is displayed.

8. Press the < > or <OK> button to select.
[Get IP Address] is displayed.

9. Press the < > or <OK> button to select.
The current set value is displayed.

10. Press the < > button until [STATIC] is 
displayed.

11. Press the <OK> button to confirm your 
selection. 
If [000.000.000.000] appears, skip to step 
15.

12. Press the < > or <Back> button to return 
to [Get IP Address].

Settings

 Admin Menu

Admin Menu

 Network / Port

Network / Port

 LPD

Network / Port

 TCP/IP Settings

TCP/IP Settings

 IP Mode

TCP/IP Settings

 IPv4 Settings

IPv4 Settings

 Get IP Address

Get IP Address

•DHCP / Autonet

Get IP Address

 STATIC

Get IP Address

•STATIC

IPv4 Settings

 Get IP Address
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13. Press the < > button to display [IP 
Address].

14. Press the < > or <OK> button to select.
The current IP address is displayed.

15. Enter the value in the first field using the 
< > or < > button (Example: 192), and 
press the < > button.

Note
• If you do not need to change the setting, press the 

< > button to advance to the next field.
• Holding down the < > or < > buttons changes the 

value in steps of 10.
• To return to the previous field, press the < > button.

16. Enter the rest of the fields in the same 
manner. After entering the last (4th) 
field(Example: 192.168.1.100), press the 
<OK> button to confirm your entry.

17. If you want to set a subnet mask and 
gateway address, press the  <Back> button 
and proceed to Step 18.
If you want to finish configuring the settings, 
proceed to Step 25.

 To Set the Subnet Mask/Gateway Address

18. Press the < > button until [Subnet Mask] 
is displayed.

19. Press the < > or <OK> button to select.
The current subnet mask is displayed.

20. Enter the subnet mask in the same way you 
entered the IP address(Example: 
255.255.255.000), and press the <OK> 
button to confirm your entry.

21. Press the <Back> button to return to 
[Subnet Mask].

22. Press the < > button to display [Gateway 
Address].

23. Press the < > or <OK> button to select.
The current gateway address is displayed.

IPv4 Settings

 IP Address

IP Address

•000.000.000.000

IP Address

 192.000.000.000

IP Address

•192.168.001.100

IPv4 Settings

 Subnet Mask

Subnet Mask

•000.000.000.000

Subnet Mask

•255.255.255.000

IPv4 Settings

 Subnet Mask

IPv4 Settings

 Gateway Address

Gateway Address

•000.000.000.000
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24. Enter the gateway address in the same way 
you entered the IP address(Example: 
192.168.1.254), and press the <OK> button 
to confirm your entry.

25. The setup is now complete.
Press the <Printer Settings> button to close 
the menu screen. 
The printer automatically restarts. 

26. Print the [Configuration Report] to verify 
your settings.

Setting an IP Address (IPv6)

The printer can use an IPv6 address in an IPv6 network environment. 

By default, the printer [IP Mode] is set to [Dual Stack] to automatically detect either IPv4 or 
IPv6. If you connect the printer to an IPv6 network, an IPv6 address is automatically set. 

Print the [Configuration Report] to verify the IPv6 address.

Note
• When setting the fixed IPv6 address on the printer, use CentreWare Internet Services to manually 

configure the settings. Then print the [Configuration Report] to verify the automatically set address. Use 
this address to access CentreWare Internet Services. Set the IPv6 address [Properties] tab > 
[Connectivity] > [Protocols] > [TCP/IP]. For information about each setting, refer to the online help for 
CentreWare Internet Services. For information about your network environment, consult with your 
network administrator. 

• For more information on CentreWare Internet Services, refer to “1.6 Configuring the Printer Using 
CentreWare Internet Services” (P. 38). For information about your network environment, consult with 
your network administrator.

Note
• For information on how to print the [Configuration Report], refer to “7.2 Printing Reports/Lists” (P. 260).

Gateway Address

•192.168.001.254
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1.5 Enabling Ports

Set all ports you want to use to [Enabled] on the control panel.

When using the standard setup, this operation is unnecessary as the default for the port is 
set to [Enabled]. 

Use the following procedure to enable each port.

The following procedure uses IPP as an example.

1. On the control panel, press the <Printer 
Settings> button to display the menu 
screen. 

2. Press the < > button until [Admin Menu] is 
displayed.

3. Press the < > or <OK> button to select.
[Network / Port] is displayed.

4. Press the < > or <OK> button to select.
[LPD] is displayed.

Note
• [Parallel] appears only when the Parallel Port Kit  

(optional) is installed.

5. Press the < > button until the desired 
protocol is displayed. (Example: IPP)

6. Press the < > or <OK> button to select.
[Port Status] is displayed.

7. Press the < > or <OK> button to select.
The current set value is displayed.

8. Press the < > button to display [Enabled].

9. Press the <OK> button to confirm your 
selection. 

10. The setting is now complete.
Press the <Printer Settings> button to close 
the menu screen. 
The printer automatically restarts. 

Settings

 LanguageEmulation

Settings

 Admin Menu

Admin Menu

 Network / Port

Network / Port

 LPD

Network / Port

 IPP

IPP

 Port Status

Port Status

•Disabled

Port Status

 Enabled

Port Status

•Enabled
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1.6 Configuring the Printer Using CentreWare 
Internet Services

Overview of CentreWare Internet Services

CentreWare Internet Services is a service that allows you to monitor or remotely configure 
the printer using a web browser when the printer is on a TCP/IP network.

Some of the control panel settings can also be set on the service’s [Properties] tab.

Note
• CentreWare Internet Services cannot be used when the printer is directly connected to the computer via 

parallel cable or USB cable.

Supported Operating Environments

 Supported Web Browsers
CentreWare Internet Services has been tested to work on the following web browsers.

Windows 7 Windows Internet Explorer 8

Windows Vista Windows Internet Explorer 7.0

Windows XP Microsoft Internet Explorer 6.0 SP2, Mozilla Firefox 3.0

Windows 2000 Microsoft Internet Explorer 6.0 SP2

Mac OS X 10.6 Safari 5, Mozilla Firefox 3.0

Mac OS X 10.5 Safari 4, Mozilla Firefox 3.0

Mac OS X 10.4 Safari 4, Mozilla Firefox 3.0

Mac OS X 10.3.9 Mozilla Firefox 3.0
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 Setting Up a Web Browser
When using CentreWare Internet Services, we recommend you specify the address of the 
printer without using a proxy server. 

Note
• If you access CentreWare Internet Services using a proxy server, the response from the service may be 

slow or the service may not be displayed. 
• For information on how to set up your web browser, refer to the online help for the web browser.

If you want to change the display language of CentreWare Internet Services, change the 
display language of your web browser.

Note
• For information on how to change the display language of your web browser, refer the online help for the 

web browser.

Also, if CentreWare Internet Services does not operate properly, use the following steps to 
configure your web browser. 

The procedure uses Internet Explorer 6.0 as an example.

1. From the [Tools] menu, select [Internet Options].

2. On the [General] tab, click [Settings] under [Temporary Internet Files].

3. Under [Check for newer versions of stored pages:] on the [Settings] dialog box, select 
either [Every visit to the page] or [Every time you start Internet Explorer]. 

4. Click [OK]. 

5. Click [OK] on the [Internet Options] dialog box. 

 Setting Up the Printer
To use CentreWare Internet Services, you must configure the printer’s IP address and 
enable [InternetServices] (default: [Enabled]). If [InternetServices] is set to [Disabled], 
change it to [Enabled] on the control panel.

Refer to
• “[InternetServices]” (P. 148)
• “1.5 Enabling Ports” (P. 37)
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CentreWare Internet Services Settings

The following are the main features on each tab of CentreWare Internet Services.

Tab Name Menu Name Feature

Status General Displays the name, IP address, and status.

Trays Displays the status of paper in the paper tray and the status of 
the output tray. 

Consumables Displays the amount and status of the consumables (estimate). 
Actual replacement of consumables must be done by checking 
the messages displayed on the control panel. 

Refer to
• “6.6 Error Messages and Error Codes” (P. 209)

Counters The number of pages printed up to the present can be displayed.

Total Runtime The operation time, standby time, and accumulated time (Low 
Power mode, Sleep mode, etc.) can be displayed.

Jobs Active Jobs Displays a list of jobs being processed. 

Job History List Displays a list of completed jobs. 

Error History Displays error information stored in the error log. Refer to “Error 
Codes” (P. 215) for more information on the meaning of error 
codes displayed.

Print Job Submission Select files stored on the computer and print them directly to the 
printer. The [Print] tab appears only when the HDD Extension Kit 
(optional) is installed.

Properties Configuration 
Overview

Displays a button to move between pages showing an overview 
of functions on the [Properties] tab. 

Description Displays the printer’s product name and serial number. You can 

also set the name *1, Location*1, Contact Person*1, 

Adoministrator’s E-mail Address*1, and Machine’s E-mail 

Address*1. 

General Setup The current setting is displayed. You can also set other items. 
• Setting

Configuration / Job Management / Paper Tray Attributes / 
Paper Settings /Power Saver Settings/Energy Saver Settings / 
Stored Job Settings / Memory Settings / Internet Services 
Settings*1 /  Cloning*1 / Calibration / Alert Notification*1

Connectivity You can check and change Network-related settings like ports 
and protocols. 

Services Allows configuration of print mode, Language Emulations, E-

mail*1, EP service*3,, and settings.

Accounting*1 You can configure settings related to accouting.

Security*1 You can configure settings related to security*1. 
• Setting 

Authentication Configuration / User Details Setup / Create 
Authorization Groups / Remote Authentication Servers / IP 
Filtering / Unbounded Port / Cerificate Settings / IPSec /
Certificate Management / IEEE 802.1x / SSL / TLS Settings / 
Audit Log /  Watermark / Force Annotation / Job Status Default 

/ System Administrator Settings*2 

Support Displays a link to support information and a site for ordering consumables.
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Using CentreWare Internet Services

Follow these steps when accessing CentreWare Internet Services.

1. Start your computer and launch a web browser.

2. In the URL field, enter the IP address or URL of the printer, and press the <Enter> 
key. The top page of CentreWare Internet Services is displayed.

Note
• When specifying a port number, enter a “:” (colon) and then “80” (the factory default port number) after 

the address. Verify the printer's port number by printing [Configuration Report].
• The port number can be changed under the [Properties] tab > [Connectivity] > [Protocols] > [HTTP]. If 

you change the port number, you must enter a “:” (colon) and then the port number after the address.

• Displays a screen for entering the user name and password when the Authentication function is set. 
Enter the ID and password of the administrator or user registered on the printer. Contact your 
administrator for information on your ID and password. User informatin is displayed on the upper right 
when CentreWare Internet Services is started up.

• After you logged in with the administrator’s passcode or the user ID and password registered in the 
printer to configure and confirm settings, make sure to click [Logout] to log out the system in order to 
prevent the leakage of information.

• When data encryption is enabled, enter “https” instead of “http” before the address when accessing 
CentreWare Internet Services.

• For information about data encryption features, refer to “7.9 Security Features” (P. 277). and “7.11 Control 
Access to Printer Features by Pre-registering Users” (P. 301).

*1 These settings can only be set using CentreWare Internet Services. They cannot be configured on
the control panel. Some security features are not supported on the model available in China.

*2 You can set the administrative ID and password. The default system administrator ID and password
are “11111” and “x-admin”, respectively.

*3 EP Service is not supported on the model available in China.

• Example - URL• Example - IP address for IPv4

• Example - IP address for IPv6
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Using the Online Help

For information about the settings on each screen, refer to the online help for CentreWare 
Internet Services. Click [Help] to display the [Help] window. 

Important
• To display the online help for CentreWare Internet Services, users need to have the environment to 

connect to the internet. The communication fee shall be borne by you.
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1.7 Installing a Print Driver

To print from your computer, install the PCL print driver from the Driver CD Kit CD-ROM.

The installation procedure varies depending on how your computer is connected to the 
printer.

For installation instructions, refer to the ‘CD-ROM Documentation (HTML)’ on the CD-ROM.

Note
• There are precautions/restrictions on drivers for Microsoft Windows XP Professional x64 Edition, 

Microsoft Windows Server 2003 x64 Editions, Microsoft Windows Vista x64, Microsoft Windows Server 
2008 x64 Editions, Microsoft Windows 7 x64 and Microsoft Windows Server 2008 R2. Read “Important 
Information” on the download page of our web site before using these drivers.

Uninstalling a Print Driver and Other Software

 To Uninstall a Print Driver
PCL print driver can be uninstalled using the uninstallation tool contained on the Driver CD 
Kit CD-ROM. For more information, refer to the ‘CD-ROM Documentation (HTML)’ on the 
CD-ROM.

 To Uninstall Other Software
When uninstalling other software installed from the Driver CD Kit CD-ROM, refer to the 
‘Readme‘ file provided for each software. The ‘Readme‘ files can be viewed under the 
‘Product Information (HTML)’ included on the Driver CD Kit CD-ROM.
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2 Basic Operation 

2.1 Main Components and Functions

Main Unit

Note
• The illustrations in this guide show the printer with the Duplex unit and 3 Tray Module installed. 

10

Front and right side of views 

No. Name Description

1 Center tray (standard) Delivers printed output face down here.

2 Control panel Switches the printer on/off.

Refer to
• “ Control Panel” (P. 47)

3 Right cover Remove this cover when installing the optional extension system memory or 
parallel port kit (optional). 

4 Accessory installation stand 
mount 

Remove this cover when installing the optional accessory installation stand 
mount. The IC card reader can be placed on the accessory installation stand. 

5 Bypass tray (standard) Open this cover to load paper. 

6 Paper tray 1 (standard) Pull out this tray to load paper. 

7 Size indicator Set here the label indicating the size of the paper set in the paper tray. 

8 Power switch Switches the printer on/off. Press the < | > side of the power switch on the 
printer to turn it on, and press the < > side to turn it off.

Refer to
• “2.2 Switching On/Off the Power” (P. 50)

9 Extension tray Pull out this tray when the printing paper is A4 portrait or larger than A4 size.

10 Paper trays 2 and 3 (optional) Up two trays identical to tray 1 can be added. 
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1

2

3
4 4

5 5
6 7

Back

Parallel interface
connector (optional)

Gigabit Ehternet Interface 
connector (optional)

This sticker lists the product 
code or SER#. Check the 
information on this sticker 
prior to contacting Fuji Xerox 
regarding an inquiry.

No. Name Description

1 Duplex unit (cover C) 
(optional) 

Open here if a paper jam occurs in the area of the Duplex unit. 

2 Power cord connector Connects the power cord. 

3 Network connector Connects the network cable. 

Note
• When the Gigabit Ethernet Board Card (optional) is inserted, connect the 

cable to connector No. 7. 

4 USB connectors Connect USB2.0 cables. 

5 Expansion device connector Connects an expansion device that can be used with the printer. 

6 Parallel interface connector 
(optional) 

When the Parallel Port Kit (Optional) is inserted, connect the parallel cable 
here.

7 Gigabit Ethernet connector 
(optional) 

When the Gigabit Ethernet Board Card (optional) is inserted, connect the 
1000BASE-T Ethernet interface cable here. 
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1 2 3 4 6 

5 
8 

7 
Interior

No. Name Description

1 Extension tray Pull out this tray when the printing paper is A4 portrait or larger than A4 size.

2 Print Cartridge The toner and drum are in one unit.

3 Cover A Open when replacing the print cartridge or removing jammed paper.

4 Transfer roll Transfers the toner image on the drum surface onto paper.

5 Paper size setting dial (bypass 
tray)

When loading paper on the bypass tray, use this dial to set the paper size.

6 Fuser Unit Fuses toner onto paper. This is extremely hot, so do not touch it.

7 Cover B When paper is jammed near the fuser unit, open this cover after opening cover 
C, and then remove the jammed paper.

8 Safety switch These switches prevent the printer from runnning when one of the printer’s 
cover is open. Do not press these switches, or place magnetic objects close to 
the switches.
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Control Panel

No. Name Description

1 <Printer Settings> button Pressed to display the menu screen.

2 Display Displays the status of the printer, menu options, and messages. 
[Please Wait...] is displayed when the printer power is switched on. Print job is 
available when the display message changes to [Ready to print].
It displays authenticated user ID for about 2 seconds when card authentication 
is used.
Nothing will be displayed during Energy Saver Mode even if the printer power is 
switched on.

Refer to
• “Control Panel Display” (P. 49)

3 <Ready> lamp Lights when the printer is ready to print.

4 <Error> lamp Blinks or lights when an error occurs.

5 <Energy Saver> button The lamp lights while the printer is in Energy Saver mode.
The printer exits Energy Saver mode by pressing this button.
The printer enters Energy Saver mode (Low Power mode) by pressing this 
button during Standby state.

Note
• <Energy Saver> lamp may be kept lit for several tens of seconds if the printer  

is switched off during Energy Saver mode.

6 <Cancel Job> button Pressed to cancel printing the job.

7 <OK> button Pressed to confirm the menu option selected on the menu screen. This button 
is also used when printing reports/lists.

8 < > < > < > < > buttons Pressed to advance to the next menu, item, or option.

Note

• When using the < > and < > buttons to change the current setting, 
holding down either button cycles through available settings at high speed. 

To display a setting’s default value, press < > and < > at the same time. 

9 <Back> button Press this button while the menu screen is displayed to return to the previous 
item. 

Online

Information

Print Menu
Back

Printer
Settings

Cancel Job

Energy Saver

ErrorReady

21 3 4

5

6

789

10

11

12
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10 <Print Menu> button Pressed to print documents stored in the printer or the server, such as Secure 
Print or Sample Set.

Note
• To use this function, either install HDD Extension Kit (optional) and extension 

system memory (optional), or if not installing HDD Extension Kit (optional), 
install the 1GB of extension system memory (optional) and [C3] enable the 
RAM disk. 

Available print function depends on your environment. Refer to “Control Panel 
Menu Tree” (P. 376) for available function for the printer.

11 <Information> button Displays detailed information on what is happening at the time by pressing this 

button when  mark appears on the display.

12 <Online> button Pressing the <Online> button takes the printer offline. The <Ready> lamp is off 
and printing is not done while the printer is offline. Pressing the <Online> button 
again takes the printer back online (printing enabled). 

No. Name Description
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Control Panel Display

The display shows two types of screens: the print screen and menu screen. The print screen 
displays messages that show the status of the printer, and the menu screen displays menus 
that allow you to set various settings for the printer.

Note
• The messages on the display vary depending on the printer status and the options installed.
• Pressing the <Information> button while the  mark is on the display shows detailed information. 

Print Screen

Shows the status of the printer. The following screens are used to indicate when the printer 
is in stand-by or printing. 

Menu Screen

Use this screen to configure printer settings. 

Press the <Printer Settings> button to display the menu screen. The following menu item 
appears when you open the menu screen. 

Refer to
• For information about the menu items in the menu screen, refer to “5 Control Panel Settings” (P. 121).

Ready to print

 Toner Left

Printer Status (Stand-by)

Toner level
(Estimate)

Printer Status (Printing)

Data input port Paper tray
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2.2 Switching On/Off the Power

Switching On the Power

1. Press the <|> side of the printer’s power 
switch to turn on the power. 

2. "Please wait" is displayed on the display of 
the control panel. Check that this display 
changes to "Ready to Print".  

Note
• When using the printer, the printer approximately 

about 20 seconds to be ready to print after the power 
is switched on. It may take longer depending on your 
machine's configuration.  

• If an error message is displayed, refer to “Error 
Messages (in Alphabetical Order)” (P. 209) to remedy 
the error.

Switching Off the Power

Important
• Do not switch the power off when the <Energy Saver> lamp is blinking. The <Energy Saver> buttom 

flashes if the HDD Extension Kit (optional) is being accessed while the printer is in the power saver 
mode. 

• Do not switch the power off when the display reads [Please wait...].
• Do not switch the power off during printing. Doing so can cause paper jams.
• Turning off power causes any print data or other data in the printer to be deleted. 
• After you turn off the power, the printer remains on for a short while as it performs an internal power off 

procedure. Do not unplug the power cord immediately after turning off the power switch. To switch on the 
power again, wait until the <Energy Saver> button has completely gone out.

• If, after switching off the power of the printer, you want to switch it on again, do so after waiting for 10 
seconds after the message on the display of the control panel and the various lamps on the control panel 
have switched off. 

1. Make sure that the printer is not in 
operation by checking the display or 
indicator lamps.

2. Press the < > side of the printer’s power 
switch to turn off power. 
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2.3 Setting/Exiting the Energy Saver Modes

The printer has Energy Saver modes that reduce electric power consumption while the 
printer is in standby. There are two Energy Saver modes: a Low Power mode (12 W or less) 
and a Sleep mode (1.7 W or less).

The Low Power mode does not turn off power completely, but it strikes a balance between 
power consumption and warm up time by keeping temperature of the fuser unit between full 
and Sleep mode. 

Important
• The life of the fuser unit depends to a large extent on the number of hours the printer is powered and 

other factors. Both Low Power mode and Sleep mode triggering cannot be disabled at the same time. 
Contact our Customer Support Center for details. 

Entering the Energy Saver Modes

The initial factory default settings for both the Low Power mode/Sleep mode trigger times 
are [1 Minutes Later], so the printer will go directly into Sleep mode without going into the 
low power mode whenever no print data is received by the printer for 1 minute.

Whether the printer enters the sleep mode can be set. Also, the time until the printer enters 
the Low Power mode or the Sleep mode can be set between 1 and 240 minutes.

Important
• When the internal temperature of the printer is high, the printer enters the Low Power mode only after 

the fan stops, so the printer may not enter the Low Power mode even if the time has been set to 1 
minute.

• Even if the time until the printer enters the Sleep mode has been set to 25 minutes or less, the inside of 
the machine must be cooled after printing, so the printer may not enter the Sleep mode for up to 25 
minutes.

• The life of the fuser unit varies greatly depending on how long the printer is powered, etc. When the time 
until the energy saver modes are entered is set to a long time, the powered time of the printer is 
correspondingly long, which may result in an earlier fuser unit replacement time. 

Note
• For information about configuring Low Power mode and Sleep mode settings, refer to “Setting Example: 

Changing the Sleep Mode Timer” (P. 124).

Exiting the Energy Saver Modes

The printer automatically exits the Energy Saver modes when it receives data from a 
computer. You can also manually exit the Energy Saver modes by pressing the <Energy 
Saver> button on the control panel. 

If the Printer Does Not Enter Energy Saver Mode

The printer does not enter Low Power mode or Sleep mode in the following cases to inform 
users on what is happening to the printer and provide its performance.

• When the user is operating the control panel

• When a message indicating to replace any one of the consumables including toner 
cartridge, drum cartridge or waste toner bottle is displayed

• When a message to replace another regular replacement part is displayed

• When the printer requires user operation for paper jams or open covers

• When an error occurs due to print failure
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2.4 Canceling/Checking a Print Job

Canceling a Print Job

Print jobs can be canceled either from your computer or the control panel.

Canceling a Print Job Being Processed on a Computer

1. Double-click the printer icon  on the task bar at the lower right corner of your 
monitor.

2. Select the name of the document whose print job you want to cancel, and then delete 
it by pressing the <Delete> key. 

Note
• If you cannot find the document in the window, cancel the document on the control panel.
• You also can cancel a print job on the [Jobs] tab of CentreWare Internet Services. For information about 

the procedure you should use, see CentreWare Internet Services help. 

Canceling a Print Job being Printed/Received on the Printer

Press the <Cancel Job> button on the control panel. Note that the page currently being 
printed continues to print. 

Canceling all Data Received by the Printer

You can use the following procedure to cancel printing all data, for instance after adding a 
very large document to the print queue. 

1. Press the <Online> button on the control 
panel. 
This causes [Off-line] to appear on the 
display.

2. Press the <Cancel Job> button. 
This starts the cancellation process. [Off-
line] appears on the display  after the 
process is complete. 

3. Press the <Online> button. 
The [Ready to print] screen reappears. 

Off-line 

 Data in memory

All data: 

Deleting Job...

Off-line 

Ready to print

 Tonner Left 



2.4 Canceling/Checking a Print Job 53

Checking the Status of a Print Job

There are two ways to check the status of data queued for printing: checking the data with 
Windows and checking the data with CentreWare Internet Services.

Checking the Job Status on Windows

1. Double-click the printer icon  on the task bar at the lower right corner of your 
monitor.

2. On the displayed window, check [Status]. 

Checking the Job Status on CentreWare Internet Services

You can check the status of print jobs also under the [Jobs] tab on CentreWare Internet 
Services. 

Refer to
• CentreWare Internet Services online help
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2.5 Importing Printer Information to a Print 
Driver

If your printer is networked, you can import printer information (such as accessory 
configuration, and sizes and types of paper in the paper trays) into your print driver using 
SNMP protocol. This can be done on the [Configuration] tab on your print driver. The 
following procedure is described based on Windows XP. After installing the print driver, use 
this procedure to obtain printer information manually for adding options and configuring 
paper settings. You can also set to obtain the printer information automatically for each print 
job.

Note
• This function is not available when the printer is directly connected to the computer via parallel cable or 

USB cable. In this case, configure settings of the applicable print driver items manually. Refer to “Set 
Printer Information Manually” (P. 58) for the procedure. In this case, the paper types and paper sizes 
loaded in the trays are not displayed. 

• To use this function, the control panel must be used to enable the printer’s SNMP port (Initial default: 
[Enabled]). 

Obtain Printer Information by Specifying Printer Name and IP Address

1. On the [Start] menu, select [Printers and Faxes] (Select [Printer] or [Devices and 
Printers] depending on OS) and display the properties of the printer being used. 

2. Click the [Configuration] tab. 

3. Click [Bi-Directional Setup].

3
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4. Click [Get Information from Printer].

Message [Done] appears if the printer information is imported to the print driver. Proceed to 
step 9.

If no printer information is imported to the print driver, [Search Printer] appears. Proceed to 
step 5.

5. Select [Specify Address].

6. Click [Next].

7. Enter printer name or IP address in [Printer Name or IP Address].

8. Click [Finish]. 

4

5

6

7

8
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9. Click [OK] to close the dialog box.

10. Click [OK].

Obtain Printer Information Automatically

You can set to obtain the printer information automatically whenever the print driver screen 
is displayed during print job.

1. On the [Start] menu, select [Printers and Faxes] (Select [Printer] or [Devices and 
Printers] depending on OS) and display the properties of the printer being used. 

2. Click the [Configuration] tab. 

3. Click [Bi-Directional Setup].

4. Select [On] in [Get Printer Information Automatically].

9

3
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5. Click [OK] to close the dialog box.

6. Click [OK].

4
5
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Set Printer Information Manually

1. On the [Start] menu, select [Printers and Faxes] (Select [Printer] or [Devices and 
Printers] depending on OS) and display the properties of the printer being used. 

2. Click the [Configuration] tab. 

3. Click [Bi-Directional Setup].

4. Select [Off] in [Get Printer Information Automatically].

5. Click [OK] to close the dialog box.

6. Click [Installable Options].

3

4
5

6
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7. Set items necessary in [Items].

8. Click [OK] to close the dialog box.

9. Click [OK].

7

8
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3 Printing

This chapter describes various printing methods using a PCL print driver.

3.1 Printing from a Computer

This section outlines the basic procedure for sending print jobs from Windows applications. 
The procedure uses Windows XP WordPad as an example.

(The actual procedure may vary depending on the application being used.)

1. On the [File] menu of your application, select [Print].

2. Use the [Select Printer] box to select the printer and then display the Properties dialog 
box. In Windows XP WordPad, click [Preferences] to display the dialog box.

3. Click the desired tab and configure print features as required. When you are finished 
with the settings, click [OK] to close the dialog box. For details on the print features, 
refer to the online help for the print driver.

4. Click [Print] on the [Print] dialog box to start printing.

To display online help:

(1) Click [?] and then the item for 
which you need help.
The help for the item appears.

(2) Click [Help].
The [Help] window appears.

(1)

(2)
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Print Features in the Properties Dialog Box

The following introduces some of the print features available on each tab of the print driver. 
For details on each feature, refer to the online help for the print driver.

Note
• The Properties dialog box also can be displayed by clicking the printer icon on the [Printers and Faxes] 

window ([Printers] or [Devices and Printers] window depending on the operating system you are using).
The settings configured here will be the defaults of the features when the dialog box is accessed from an 
application.

Tab Feature

Paper/Output • 2-Sided Print
Prints documents on 
both sides of the paper.

• Saved Settings
Allows registration of 
frequently-used print 
settings. The printer can 
be configured with 
multiple settings simply 
by selecting an item 
from the list. Settings 
can be edited and pre-
registered as required. 

• Secure Print
Allows temporary 
storage of a document in 
the printer for manual 
printing from the control 
panel.
(The optional HDD 
Extension Kit (optional) 
and extension system 
memory is needed.)

• Sample Set
Allows printing of a proof 
copy of a multi-set job. 
After the proof copy is 
checked, the remainder 
of the job can be printed 
from the control panel. 
(The optional HDD 
Extension Kit (optional) 
and extension system 
memory is needed.)

• Delayed Print
Allows printing at a 
specified time. 

• Covers/Separators
Allows inserting Front 
Cover, Back Cover or 
Separator. 
Also allows printing on 
paper of a specific color 
and thickness for Front 
Cover only.

Image Options • Allows you to configure settings related to print quality, such as saving toners or 
adjusting positions of images.

• Image quality
The image quality can be adjusted according to the type of document to be printed, 
such as photos or charts, and the intended use. 

• Toner saver 
This function reduces toner consumption. 

Layout/
Watermark

• Pages Per Sheet (N-up)
Prints multiple pages 
onto one sheet of paper.

• Poster
Allows you to divide and enlarge an original document 
to copy the image onto multiple sheets of paper. You 
can then paste them together to make one large 
poster.

• Watermark
Adds a watermark such as “Confidential” underneath an 
original image.
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3.2 Printing on Envelopes

This section describes how to print on envelopes.

Postcards/envelopes can be printed when using Tray 1-3.

Loading Envelopes

Only printing on the address side of the envelope is supported. Printing on the reverse side 
is not supported. 

The following envelope sizes can be used with this printer. 

Note
• When using custom size envelopes, register the custom size with the printer driver as a user-defined 

size. For details, refer to “Registering Custom Size Paper” (P. 67) 
• For user-defined sizes, register the size including the flap in the case of envelopes with their flap open. 

(In the case of Ncolor envelopes, 20 mm can be included as the flap part.)

Important
• For best print quality, do not use envelopes that:

• are curled or twisted.
• are stuck together or damaged.
• have windows, holes, perforations, cutouts, or embossments.
• use tie strings, metal clamps, or metal folding bars.
• have postage stamps attached.
• have any exposed adhesive when the flaps are closed.
• have deckle edges or creased corners.
• are wrinkled, rough or are glued. 
• have adhesive flaps.

1. Load horizontal envelopes with the address 
size facing up, the flap closed, and so they 
feed from the side with the flap. 

Note
• When using envelopes with adhesive flaps, close the 

flaps and set the envelopes so that they feed from the 
flap side. Setting envelopes with adhesive flaps with 
their flaps open will cause printer malfunction.

Load vertical envelopes with the address 
side facing up with the flaps to the right.

Note
• Envelopes can be printed even when their flaps point 

left. Correctly select the right setting according to the 
flap direction with [Portrait/Landscape (For 
Envelopes)] > [Image Rotation 180 Degrees] in [Mixed 
Sizes ] of the printer driver.

• Envelope (120 x 235mm) • Monarch envelope (98x191mm)

• Envelope (105 x 235mm) • DL envelope (110x220mm)

• C5 envelope (162x229mm) • No.10 Envelope (105x241mm)

 horizontal envelopes
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2. Adjust the paper guides to the size of the 
envelopes.

3. Set the paper size setting dial on the 
bypass tray to "Other." 

4. Set the paper size for the bypass tray on 
the control panel. 

Refer to
• “Loading Paper in the Bypass Tray” (P. 107).

Printing on Envelopes

The following procedures use Windows XP WordPad as an example.

Note
• The method for displaying the Properties dialog box varies depending on the application being used. 

Refer to the documentation for the application.

1. On the [File] menu, select [Print].

2. Select the printer from the [Select Printer] list box, and then click [Preferences].

3. The [Paper/Output] tab appears. Click <v> beside the [Paper] to display the options, 
and then select [Advanced Paper Selection].

 envelopes

3
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4. For [Paper Tray], select [Tray 5 (Bypass)].

5. 5.Click <v> beside the [Paper] to display the options, and then select [Advanced 
Paper Selection]. 
[Advanced Paper Selection] is appear.

4
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6. If the output paper size is different from the file size, choose [Automatically Scale] for 
[Scale Options], and then select output paper size for [Output Paper Size]

7. Click [OK] to close the [Advanced Paper Selection] dialog box.

8. On the [Paper/Output] tab, click [OK].

9. Click [Print] on the [Print] dialog box to start printing.
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3.3 Printing on Custom Size or Long-size 
Paper

This section explains how to print on long-size and custom size paper. 

The following are the sizes of paper that can be loaded into the paper trays.

Loading Custom Size or Long Size Paper

Using the Bypass Tray

The following example explains how to load long-size paper into the bypass tray. 

Note
• Finger prints can leave marks on the printing surface of long-size paper. Take care to avoid getting 

marks on the long size paper when loading it.
• For information about loading other custom size paper, refer to “4.2 Loading Paper” (P. 107).
• The only paper type setting that can be specified for long size paper is [Custom (297 - 900 mm)].

1. Load the paper into the bypass tray with the 
print side of the long-size paper facing up 
and the trailing edge curled as shown in the 
illustration. 

Note
• Curl the trailing edge of the long-size paper as far as 

possible from the paper inlet slot. Curling it too close 
to the paper inlet slot can result in the trailing edge 
feeding into the printer, causing the paper to be 
creased or wrinkled.

• Carefully insert the leading edge of the paper into the 
inlet slot of the bypass tray. Incorrect insertion can 
cause paper jams.

• Load paper one sheet at a time.

2. Adjust the paper guide to the size of the 
long-size paper. 
Since long-size paper is long, be sure to 
pick up each printed sheet as it comes out 
to avoid it from falling to the floor. 

 Bypass Tray  Trays 1 - 3

Width:
75 - 297 mm

Length:
98 - 432 mm

Paper feed direction

* The long size of 900x297mm can be used. 

Width:
76 - 297 mm

Length:
148 - 432 mm

Paper feed direction
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Using Trays 1 - 3

The procedure for loading custom size paper into Trays 1 - 3 is the same as for standard- 
size paper. Refer to “4.2 Loading Paper” (P. 107).

Registering Custom Size Paper

Custom size paper needs to be registered with the print driver before it can be used. The 
following example shows how to do this with Windows XP.

When loading custom size paper in tray 1, 2, or 3, use the control panel to configure the 
paper size settings. For information on how to configure settings on the control panel, refer 
to “Setting the Paper Sizes of Trays” (P. 115).

Important
• Make sure the paper size settings are configured correctly with the print driver or on the control panel. 

Setting the wrong paper size can cause malfunction of the printer.

Note
• Only users with administrator level access authority can change settings. Users without administrator 

privileges can only view settings.
• Changing the settings on the [Custom Paper Size] dialog box when running Windows 2000, Windows 

XP, Windows Server 2003, or Windows Vista while the printer is being used as a local printer can affect 
settings for other printers on your computer. Changing settings when the printer is a network printer can 
affect other network-shared printers on other computers over the network. This is because the printer 
uses its own form database when it is local, while it uses the form database of a server that has a print 
queue when it is networked.

1. On the [Start] menu, select [Printers and Faxes] (Select [Printer] or [Devices and 
Printers] depending on OS) and display the properties of the printer being used.

2. Click the [Device Settings] tab.
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3. Click [Custom Paper Size].

4. Click [Setup].

2

3

4
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5. Select custom items to be set from the list box for paper name and size.

Note
• In the case of Windows 7, select the name of the paper for which a custom size is to be registered from 

[Custom 1] to [Custom 20].
• If changing paper name, select the [Create a New Form] check box and then enter a name in [Paper 

Name]. A paper name can be up to 31 single-byte characters long. 

6. Specify the length for [Width] and [Length]. 
Use key input or the [ ] and [ ] keys to specify the lengths.
Even if the [Width] setting is within the allowable range, you cannot specify a value 
that is greater than the [Length] setting. Conversely, even if the [Length] setting is 
within the allowable range, you cannot specify a value that is less than the [Width] 
setting.

7. To define other custom paper sizes, repeat Steps 5 to 6 of this procedure. 

8. Click [Save].

Note
• Proceed to step 10 when registering with a new paper name.

9. Click [Yes].

10. Click [Close].

11. Click [OK].

5

7

6
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Printing on Custom Size Paper

The following procedure uses Windows XP WordPad as an example.

Important
• Make sure to set paper sizes correctly. Setting wrong paper sizes can cause printer malfunctions.

Note
• The method for displaying the Properties dialog box varies depending on the application being used. 

Refer to the documentation of the application.

1. On the [File] menu, select [Print].

2. Select the printer from the [Select Printer] list box, and then click [Preferences].

3. The [Paper/Output] tab appears.
Click <v> beside the [Paper] to display the options, and then select the registered 
custom paper size from [Size].

4. When the paper is loaded in the Bypass Tray, click <v> beside the [Paper] to display 
the options, and then select [Advanced Paper Selection].

5. Click [OK] to close the [Advanced Paper Selection] dialog box.

6. Click [OK].

7. Click [Print] on the [Print] dialog box to start printing.
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3.4 Printing various types of papers

The trays 1 - 3 accept plain paper and special media such as heavyweight paper, labels, 
and transparencies.

This section describes how to print after changing the paper type settings of tray 1, 2, or 3.

The following procedures use Windows XP WordPad as an example.

Important
• The method for displaying the Properties dialog box varies depending on the application being used. 

Refer to the documentation for the application.

Note
• Paper type setting method: “ Setting the Paper Sizes of Trays” (P. 115) and “ Changing the Paper Type 

Settings of Trays” (P. 117).
• Loading settings to the printer driver: “2.5 Importing Printer Information to a Print Driver” (P. 54)

Automatically Printing after Changing the Paper Type 

When the [Paper Type] settings match the loaded paper type in the tray, the printer will 
select the appropriate tray based on the paper type setting you specified, even if you do not 
specify a paper tray with the print driver. 

This method makes it possible to request a print job without worrying about the type of paper 
loaded in each paper tray.

In order to use this feature, use the control panel to configure paper type settings for the 
printer trays.

1. On the [File] menu, select [Print].

2. Select the printer from the [Select Printer] list, and then click [Preferences].

3. Click <v> beside the [Paper] to display the options, and then select [Advanced Paper 
Selection].

4. For [Paper Tray], select [Automatically Select]. 

5. For the [Paper Type], select the paper type to print.

6. Set the [Original Document Size]. 

3
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7. If the output paper size is different from the file size, choose [Automatically Scale] for 
[Scale Options], and then select output paper size for [Output Paper Size].

8. Click [OK] to close the [Advanced Paper Selection] dialog box.

9. Click [OK].

10. Click [Print] on the [Print] dialog box to start printing.
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3.5 Printing confidential documents 
- Secure Print - 

The Secure Print function can be used when HDD Extension Kit (optional) and extension 
system memory (optional) are installed on the printer, or the extension system memory 
(1GB) (optional) is installed and RAM disk is enabled. 

Important
• In case the HDD Extension Kit (optional) fails, we recommend you to back up the HDD Extension Kit 

(optional) data on your computer.
• All documents stored may be deleted if the printer power is turned off and on, while using RAM disk.

Refer to
• How to enable RAM disk:“7.8 Enabling a RAM Disk” (P. 275)

Secure Print

Secure Print is a feature that allows you to send a password-protected document to the 
printer. Instead of printing the document immediately, the printer stores it temporarily until 
you use the control panel to start printing manually. This feature also can store documents 
that are not password protected. By storing frequently-used documents in the printer, you 
can print them whenever you want, without having to send them each time from your 
computer.

Note
• Whether or not to delete a Secure Print job after printing it can be specified when you print it from the 

control panel. For more information, refer to “Control Panel Operations” (P. 75).
• Secure Print output is not supported when [Disabled] is selected for [Secure Print] on the control panel.
• Password input is always required when the [Minimum Passcode Length] setting on the [Configuration] 

tab > [Installable Options] > [Installable Options] dialog box of the printer’s properties dialog box is [1] or 
greater. 

Printing with Secure Print 

The following explains how to print a job with Secure Print.

Configure Secure Print settings on your computer and then send the job to the printer. Next, 
perform the required control panel operation to start printing manually.

Computer Operations

The following procedure uses Windows XP WordPad as an example.

Note
• The method for displaying the Properties dialog box varies depending on the application being used. 

Refer to the documentation for the application.

1. On the [File] menu, select [Print].

2. Select the printer from the [Select Printer] list box, and then click [Preferences].

Send
Order printing from 
the control panel.

Stored
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3. The [Paper/Output] tab appears.
For [Job Type], select [Secure Print].

4. Click [Setup]. 
The [Secure Print] dialog box appears.

5. Enter your user ID into [User ID].
The user ID can be up to 8 single-byte alphanumeric characters.

6. If a password is assigned to the job, enter the password into [Secure Print Passcode].
The password can be up to 12 single-byte numeric characters.

7. For [Job Name], select [Enter Job Name] or [Use Existing Name].
If you selected [Enter Job Name], name the document by entering up to 12 single-byte 
characters into [New Job Name].
If you selected [Use Existing Name], the document name will be the name of the 
document to be printed. If the printer cannot identify the name of the document, the 
date and time that the document will be printed is used for the name.

8. Click [OK]. 

9. On the [Paper/ Output] tab, click [OK].

10. Click [Print] on the [Print] dialog box to start printing.
This will store the document in the printer. 

3

5

7

6



3.5 Printing confidential documents - Secure Print - 75

Control Panel Operations

The following explains how to print a Secure Print job stored in the printer.

Note
• To delete a Secure Print job without printing it, select [Delete] after Step 8.

1. On the control panel, press the <Print 
Menu> button.

2. Press the < > or <OK> button to select.
A user ID appears.

3. Press the < > button until the desired user 
ID appears.

Note
• The user ID is the ID set for [User ID] on the [Secure 

Print] dialog box of the print driver.

4. Press the < > or <OK> button to select.
A screen that allows you to enter a 
password appears.

5. Enter your password using the < > and 
< > buttons. Use the < > button to move 
the cursor.

Note
• Enter the password you specified for [Secure Print 

Passcode] on the [Secure Print] dialog box of the print 
driver. When a password is not specified, the control 
panel will not prompt you for entry of a password.

6. Press the <OK> button to apply the setting.
A document name appears. 

7. Press the < > button until the desired 
document name appears.

Note
• The document name is the name (of up to 12 bytes) 

specified for [Job Name] on the [Secure Print] dialog 
box of the print driver.

• When more than one document is stored in the printer, 
an [All Jobs] option is also available.

Print Menu

 Secure Print

Select User ID

 1001.12345678

Passcode+OK key

 [0           ]

Passcode+OK key

 [**7         ]

Select Job

1.Report
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8. Press the < > or <OK> button to select.
A screen appears that allows you to specify 
whether to delete or save the document 
after printing.

Note
• To delete the job without printing, press the < > 

button to display [Delete], press the < > button, and 
then press the <OK> button.

• If you want to save the document in the printer after 
printing, press the < > button, display [Print & Save], 
and proceed to Step 9 of this procedure.

9. Press the < > or <OK> button to select.
A screen to enter the number of copies 
appears.

10. Enter the number of copies using the < > 
button, and then press the < > or <OK> 
button to print the document.
A print start confirmation screen appears.

11. Press the <OK> button to print.
Printing starts.

12. Press the <Print Menu> button to return to 
the [Ready to print] screen.

1.Report

 Print & Delete

Quantity

 1 Set(s)

1.Report

Use OK to print
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3.6 Printing after checking output
 - Sample Set - 

Sample Set is available if the printer has HDD Extension Kit (optional), or else install 
extension system memory (1GB) (optional) and RAM disk enabled.

Important
• In case the HDD Extension Kit (optional) fails, we recommend you to back up the HDD Extension Kit 

(optional) data on your computer.

Sample Set

Sample Set lets you print a proof copy of a multi-set job and print the rest of the sets after 
checking the proof copy. The job is stored on the printer’s HDD Extension Kit (optional) until 
all of the sets are printed using the control panel.

Note
• To delete Sample Set jobs that have accumulated on the printer, without printing them, refer to “Control 

Panel Operations” (P. 79).

Printing Using Sample Set

The following explains how to use Sample Set to print a job.

Configure Sample Set settings on your computer and then send the job to the printer. Next, 
perform the required control panel operation to start printing manually.

Computer Operations

The following procedure uses Windows XP WordPad as an example.

Note
• The method for displaying the Properties dialog box varies depending on the application being used. 

Refer to the documentation for the application.

1. On the [File] menu, select [Print].

2. Select the printer from the [Select Printer] list box, and then click [Preferences]. The 
[Paper/Output] tab appears.

Send
Stored

1 set printed

Proof print 
OK

Something wrong 
with proof print.

Cancel the job on the control panel.

Print the rest of the sets 
using the control panel.
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3. For [Job Type], select [Sample Set].

4. Click [Setup]. 
The [Sample Set] dialog box appears.

5. Enter your user ID into [User ID].
The user ID can be up to 8 single-byte alphanumeric characters.

6. For [Job Name], select [Enter Job Name] or [Use Existing Name].
If you selected [Enter Job Name], name the document by entering up to 12 single-byte 
characters into [New Job Name].
If you selected [Use Existing Name], the document name will be the name of the 
document to be printed. If the printer cannot identify the name of the document, the 
date and time that the document will be printed is used for the name.

7. Click [OK].

8. On the [Paper/ Output] tab, click [OK].

9. Click [Print] on the [Print] dialog box to start printing.

3

7

6
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Control Panel Operations

The following explains how to print or delete a Sample Set job depending on the proof print 
result.

1. On the control panel, press the <Print 
Menu> button.

2. Press the < > button until [Sample Set] 
appears.

3. Press the < > or <OK> button to select.
A user ID appears.

4. Press the < > button until the desired user 
ID appears.

Note
• The user ID is the ID specified for [User ID] on the 

[Sample Set] dialog box of the print driver.

5. Press the < > or <OK> button to select.
A document name appears.

6. Press the < > button until the desired 
document name appears.

Note
• The document name is the name (of up to 12 bytes) 

specified for [Job Name] on the [Sample Set] dialog 
box of the print driver.

• When more than one document is stored in the printer, 
an [All Jobs] option is also available.

7. Press the < > or <OK> button to select.
A screen appears that allows you to specify 
whether to delete or save the document 
after printing.

Note
• To delete the job without printing, press the < > button 

to display [Delete], press the < > button, and then 
press the <OK> button.

8. When printing the document, use the < > 
or <OK> button to select. 
A screen to enter the number of copies 
appears.

Print Menu

 Secure Print

Print Menu

 Sample Set

Select User ID

 2001.12345678

Select Job

1.Report

1.Report

 Print

Quantity

 1 Set(s)
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9. Enter the number of copies using the < > 
button, and then press the < > or <OK> 
button to print the document.
A print start confirmation screen appears.

Note
• The initial number of copies is one less than the 

number preset in the print driver because one copy 
has already been printed.

10. Press the <OK> button to print.
Printing starts.

11. Press the <Print Menu> button to return to 
the [Ready to print] screen.

1.Report

Use OK to print
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3.7 Printing at a Specified Time
 - Delayed Print - 

Delayed Print is available if the printer has HDD Extension Kit (optional), or else install 
extension system memory (1GB) (optional) and RAM disk enabled.

Important
• In case the HDD Extension Kit (optional) fails, we recommend you to back up the HDD Extension Kit 

(optional) data on your computer.

Delayed Print

Delayed Print stores print data on the HDD Extension Kit (optional) and prints it 
automatically at a preset time. 

The number of jobs which can be executed (held) at the same time is 100 jobs or less.

Important
• Do not turn off the printer power while a Delayed Print job is pending. 

If the printer power is turned off (before the specified time) while print job is in stand-by and HDD 
Extension Kit (optional) is used, print job which passed specified time starts automatically as soon as the 
power is turned back on for the next time.

Note
• The time setting for Delayed Print must be within 24 hours after the print job is requested. 

Registering a Delayed Print Job

This procedure explains how to print a job with Delayed Print.

It uses Windows XP WordPad as an example.

1. On the [File] menu, select [Print].

2. Select the printer from the [Select Printer] list, and then click [Preferences].

3. For [Job Type] on the [Paper/ Output] tab, select [Delayed Print].

4. Click [Setup]. 
The [Delayed Print] dialog box appears.

3
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5. Specify the printing start time. 
Use 24-hour format to specify the time. 

6. For [Job Name], select [Enter Job Name] or [Use Existing Name]. If you selected 
[Enter Job Name], name the document by entering up to 12 single-byte characters 
into [New Job Name].
If you selected [Use Existing Name], the document name will be the name of the 
document to be printed. If the printer cannot identify the name of the document, the 
date and time that the document will be printed is used for the name.

7. Click [OK].

8. On the [Paper/ Output] tab, click [OK].

9. Click [Print] on the [Print] dialog box to start printing.
Printing will start when the specified time is reached. 

Canceling a Delayed Print Job

You can use the control panel to cancel a Delayed Print job or to print a Delayed Print job 
immediately, regardless of the specified time. 

1. On the control panel, press the <Print 
Menu> button.

2. Press the < > button until [Delayed Print] 
is displayed.

3. Press the < > or <OK> button to select.
A document name appears.

4. Press the < > button until the desired 
document name appears.

Note
• The document name is the name (of up to 12 bytes) 

specified for [Job Name] on the [Delayed Print] dialog 
box of the print driver.

Print Menu

 Secure Print

Print Menu

 Delayed Print

Select Job

1.Report
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5. Press the < > or <OK> button to select.
A screen for selecting whether to print 
immediately or to delete the job without 
printing appears. 

Note
• If you want to delete the job without printing, press the 

< > button to display [Delete], press the < > button, 
and then press the <OK> button.

6. To print the document immediately, use the 
< > or <OK> button to select. 
A print start confirmation screen appears.

7. Press the <OK> button to print.
Printing starts.

8. Press the <Print Menu> button to return to 
the [Ready to print] screen.

1.Report

 Print Now

1.Report

Use OK to print
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3.8 Private Charge Print

Private Charge Print is available if the printer has HDD Extension Kit (optional), or else 
install extension system memory (1GB) (optional) and RAM disk is enabled.

Important
• In case the HDD Extension Kit (optional) fails, we recommend you to back up the HDD Extension Kit 

(optional) data on your computer.
• All documents stored may be deleted if the printer power is turned off and on, while using RAM disk.

Refer to
• How to enable RAM disk: “7.8 Enabling a RAM Disk” (P. 275)

Private Charge Print

Private Charge Print is a function to store print job data from a computer temporarily in the 
printer and then print it when necessary with Smart card verification, if IC Card Reader 
(optional or purchase separately) is connected to the printer.

Print job data from a computer is saved by each user ID for authentication, so that only 
documents of the user corresponded to the information on Smart card authentication can 
be printed.

Note
• The IC Card Reader may not be supplied with the printer in some regions. Contact your dealer for　

details.
• The Authentication feature includes login to local accounts, which uses user IDs and other login 

information registered on the printer, and login to remote accounts with an affiliated external 
authentication server. Contact your dealers for information about using the Authentication feature. 

• If IC Card Reader is connected, print job data for Secure Print and Sample Set already stored in the printer 
may not be available to use. In this case, print or delete print job data before connecting IC Card Reader.

• Print jobs using Watermark and Secure Watermark are available for printing by releasing these 
functions, when selecting [Print Menu] > [DisableForcePrint] on the control panel. This option is available 
only for users having authority to temporarily exit forced print.
Refer to “ Create Authorization Group and Association with Users” (P. 304) for information on setting 
authority to temporarily exit forced print. Refer to “7.9 Security Features“ > “ Using the Watermark 
Feature” (P. 279) for Watermark and Secure Watermark features.

• If Private Charge Print feature is set, ordinary print, Secure Print, Sample Set and Delayed Print are not 
available.

Configuring Private Charge Print Settings

Configuring Printer Settings

Private Charge Print is displayed if either of the following is set in [Admin Menu] > [System 
Settings] > [Authentication] > [Charge Print] of the control panel.

• When [Receive Control] is set to [PrivateChargePrint].

• When [Receive Control] is set to [ReferPrintAuditron] while [PrivateChargePrint] is set in 
[Process Job Login] > [Job Login Success].

Refer to
• “ Secure Print” (P. 85)
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Configuring Print Driver Settings

To use Private Charge Print, a user ID must be specified on the print driver properties dialog 
box. Printing is not possible if the user ID does not match the verification information. 

For details about the content of settings and setting procedures, consult your system 
administrator. 

Printing with Private Charge Print 

With Private Charge Print, user can print job stored in the printer by touching Smart card.

1. While [Ready to print] is displayed on the 
control panel, make sure to touch Smart 
card for authentication.

Documents are printed automatically
if authentication of the user is successful.

Deleting Print Job

The following explains how to delete print job stored in the printer in Private Charge Print.

1. On the control panel, press the <Print 
Menu> button.

2. Press < > button until [Del PteChgePrint] 
appears.

3. Select with < > or <OK> button.
The screen shown to the right appears.

4. Make sure to touch Smart card for 
authentication.
Document name is displayed if 
authentication is successful.

5. Press < > button until the desired  
document name appears.

Note
• When more than one document is stored in the 

printer, an [All Jobs] option is also available.

6. Select with < > or <OK> button.
The screen to start deleting print job 
appears.

Ready to print

 Toner Left 

Printing...

Print Menu

 Secure Print

Print Menu

 Del PteChgePrint

Use Smart Card

to login

Select JobToDelete

1.Report

1.Report

 Use OK to delete
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7. Press <OK> button.
Print job is deleted.

8. Press the <Print Menu> button to return to 
the [Ready to print] screen.
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3.9 Charge Print

Charge Print is available if the printer has HDD Extension Kit (30GB) (optional).

Important
• In case the HDD Extension Kit (optional) fails, we recommend you to back up the HDD Extension Kit 

(optional) data on your computer.

Charge Print

Charge Print is a function to allow the printer to prevent invalid print job based on Smat card 
authentication of the user, if IC Card Reader is connected to the printer.

If [Admin Menu] > [System Settings] > [Authentication] > [Charge Print] > [Receive Control] 
of the control panel is set to [Save inChargePrint], print job data from a computer will be 
temporarily saved in the printer by each Billing ID. Print job data without a Billing ID will be 
saved as [No User ID]. Print job data saved is available for printing by the user operation 
from a printer.

Note
• Print job without a user ID is also available for printing by authentication, since print job without a user ID 

which cannot be saved in Private Charge Print (Print job using ContentsBridge and CentreWare Internet 
Services, Mail Print, etc.) can be saved.

• The IC Card Reader may not be supplied with the printer in some regions. Contact your dealers for　
details.

• The Authentication feature includes login to local accounts, which uses user IDs and other login 
information registered on the printer, and login to remote accounts with an affiliated external 
authentication server. Contact your dealers for information about using the Authentication feature. 

• If IC Card Reader is connected, print job data for Secure Print and Sample Set already stored in the 
printer may not be available to use. In this case, print or delete print job data before connecting IC Card 
Reader.

Configuring Charge Print Settings

Configuring Printer Settings

Charge Print is displayed if any of the following is set in [Admin Menu] > [System Settings] 
> [Authentication] > [Charge Print] of the control panel.

• When [Receive Control] is set to [Save inChargePrint].

• When [Receive Control] is set to [ReferPrintAuditron] while [Save as ChargePrint] is set 
in [Process Job Login] > [Job Login Failure].

• When [Receive Control] is set to [ReferPrintAuditron] while [Save as ChargePrint] is set 
in [Process Job Login] > [Job Without User ID].

• When [Receive Control] is set to [Save as Private Charge Print Job] while [Save as 
Charge Print] is set in [Process Job Login] > [Job Without User ID].

Refer to
• “3.9 Charge Print” (P. 87)

Configuring Print Driver Settings

Set Billing ID on the print driver properties dialog box. In addition to Billing ID, passcode 
must be set to prevent other users from operating your documents.
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Printing with Charge Print 

The following explains how to use Charge Print to print  a job stored in the printer.

1. On the control panel, press the <Print 
Menu> button.

2. Press < > button until [Charge Print] 
appears.

3. Select with < > or <OK> button.
The screen shown to the right appears if IC 
Card Reader is connected to the printer. 
Make sure to touch Smart card for 
authentication. 
The screen shown in Step 4 appears if 
authentication is successful. Proceed to 
Step 4.
The screen shown to the right does not  
appear if no IC Card Reader is connected 
to the printer. Proceed to Step 4.

4. User ID is displayed.
Press < > button until the desired  user ID 
appears.

Note
• Select [(No User ID)] for user ID if printing documents 

with no Billing ID set.

5. Select with < > or <OK> button.
The screen shown to the right appears if 
passcode is set. Proceed to Step 6.
The screen to select document appears if 
no passcode is set. Proceed to Step 8.

6. Enter your passcode using the < > and 
<  > buttons. Use the < > button to move 
the cursor.

7. Press the <OK> button to apply the setting. 
A document name appears.

8. Press < > button until the desired  
document name appears.

Note
• When more than one document is stored for the 

specific user ID, an [All Jobs] option is also available.

Print Menu

 Secure Print

Print Menu

 Charge Print

Use Smart card

to login

Select User ID

 7001.(No User ID)

Select User ID

 7002.12345678

Passcode+OK key

 [0            ]

Passcode+OK key

 [**7          ]

Select Job

 1.Report
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9. Press the < > or <OK> button to select. 
A screen appears that allows you to specify 
whether to delete or save the document 
after printing.

Note
• To delete the job without printing, press the < > button 

to display [Delete], press the < > button, and then 
press the <OK> button.

• If you want to save the document in the printer after 
printing, press the < > button, display [Print & Save], 
and proceed to Step 10.

10. Select with < > or <OK> button.
A screen to enter the number of copies 
appears.

11. Enter the number of copies using the < > 
button, and then press the < > or <OK> 
button to print the document. A print start 
confirmation screen appears.

12. Press the <OK> button to print.
Printing starts.

13. Press the <Print Menu> button to return to 
the [Ready to print] screen.

1.Report

 Print & Delete

Quantity

 1 Set(s)

1.Report

 Use OK to print
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3.10 Direct Printing of PDF Files

Some PDF files can be sent directly to the printer without using a print driver. Direct printing 
of PDF files is much easier and faster compared to printing them using a print driver. 

You can select from the following modes to print PDF files directly, the one is a mode using 
PDF Bridge feature that comes standard with the printer, or the other one is a mode using 
PostScript feature. 

Set print process mode for PDF files on [Process Mode] of [PDF] on the control panel.

Refer to
• “ [PDF]” (P. 126)

Supported PDF Files

PDF files created on Adobe Acrobat 4 to Adobe Acrobat 9 can be printed on the printer. 
Note, however, that the following features are not supported. 

• When using PDF Bridge feature: Some features added from PDF 1.5 and later

• When using PostScript: Some features added from PDF 1.7 and later

Although Adobe PDF 1.6 supports PDF Direct Print feature, please note the following 
points.

When using PostScript

• PDF1.6 features such as transparent objects are supported, but rendering being 
complex, PDF output may take time.

• It does not support the settings for embedding OpenType font in Adobe Acrobat 7 
(PDF1.6).

• Although it supports features of PDF1.6 created in Adobe Acrobat 7 and later, it does not 
support features of PDF1.7 (Adobe Acrobat 8 and 9).

• Depending on how they are created, some PDF files cannot be printed directly. In that 
case, open the files and print them using a print driver.

Printing PDF Files Directly

There are several methods for printing PDF files directly.

Important
• For direct printing of PDF files using the USB or parallel port, use the ContentsBridge Utility.

Printing PDF Files Using ContentsBridge Utility

The ContentsBridge Utility is a software by Fuji Xerox to send files from a computer directly 
to the printer for printing. 
The ContentsBridge Utility is on the Driver CD Kit CD-ROM. To use ContentsBridge Utility, 
refer to the manual on the CD-ROM. 

Note
• In addition to PDF files, ContentsBridge Utility also can be used to print DocuWorks, TIFF, JPEG and 

XML Paper Specification (XPS) files. 
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Printing PDF Files Using CentreWare Internet Services

Printing of PDF files can be instructed directly to the printer by specifying PDF files from 
[Print] tab of CentreWare Internet Services. For more information, refer to the online help 
for CentreWare Internet Services.

Note
• To use this feature, you are required to install HDD Extension Kit (optional) and Extension System 

Memory (optional).
• In addition to PDF files, CentreWare Internet Services also can be used to print DocuWorks, TIFF, JPEG 

and XML Paper Specification (XPS) files.

Printing PDF Files Using E-mail

E-mail can be sent from a computer to the printer by attaching PDF files for printing. For 
more information, refer to “3.12 Printing Using E-mail - E-mail Print -” (P. 94).

Note
• To use this feature, you are required to install HDD Extension Kit (optional).

Sending PDF Files Using Lpr Command

PDF files can be sent directly to the printer using commands such as lpr. When printing with 
commands, the following items are printed according to [PDF] settings on the control panel.

Refer to
• “[PDF]” (P. 126)

Note
• [Layout] does not appear when [PS] is selected for [Process Mode]. 
• "2 Sided Printing" is displayed when the Duplex unit (optional) is installed. 
• When printing using the lpr command, use the lpr command to specify the number of copies. In such 

cases, the [Quantity] setting on the control panel becomes invalid. If you do not specify the number of 
copies using the lpr command, the printer assumes 1 set. 

The following is an example of printing a PDF file from a computer using the lpr command. 

Note
• In the following examples, the bold characters are input characters.
• Spaces are indicated with r.

Example

At the command prompt, enter the command as follows.

Example: A command for printing “event.pdf” when the printer’s IP address is 
192.168.1.100.

• Process Mode • Collated

• Quantity • Layout

• 2 Sided Printing • Output Size

• Print Mode

• Password

C:\>lprr-Sr192.168.1.100r-Prlprevent.pdf <Enter> key
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3.11 Direct Printing of DocuWorks Files

DocuWorks files can be sent directly to the printer for printing without using a print driver. 
Direct printing of PDF files is much easier and faster compared to printing them using a print 
driver. 

Supported DocuWorks Files

The following DocuWorks files can be printed. 

• DocuWorks Ver. 3 - 7 documents (Extension: .xdw)

• DocuWorks Ver. 4 - 7 binder documents (Extension: .xbd)

Note
• Self-extracting documents (Extension: .exe) cannot be printed.
• Depending on how they are created, some PDF files cannot be printed directly. In that case, open 

DocuWorks files and print them using a print driver.

Printing DocuWorks Files Directly

There are several methods for printing DocuWorks files directly.

Important
• For direct printing of DocuWorks files using the USB or parallel port, use the ContentsBridge Utility.

Printing DocuWorks Files Using ContentsBridge Utility

The ContentsBridge Utility is a software by Fuji Xerox to send files from a computer directly 
to the printer for printing. 
The ContentsBridge Utility is on the Driver CD Kit CD-ROM. To use ContentsBridge Utility, 
refer to the manual on the CD-ROM. 

Note
• In addition to DocuWorks files, ContentsBridge Utility also can be used to print PDF, TIFF, JPEG and 

XML Paper Specification (XPS) files. 

Printing DocuWorks Files Using CentreWare Internet Services

Printing of DocuWorks files can be instructed directly to the printer by specifying 
DocuWorks files from [Print] tab of CentreWare Internet Services. For more information, 
refer to the online help for CentreWare Internet Services.

Note
• To use this feature, you are required to install HDD Extension Kit (optional).
• In addition to DocuWorks files, CentreWare Internet Services also can be used to print PDF, TIFF, JPEG 

and XML Paper Specification (XPS) files.

Printing DocuWorks Files Using E-mail

E-mail can be sent from a computer to the printer by attaching DocuWorks files for printing. 
For more information, refer to “3.12 Printing Using E-mail - E-mail Print -” (P. 94).

Note
• To use this feature, you are required to install HDD Extension Kit (optional).
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Sending DocuWorks Files Using Lpr Command

DocuWorks files can be sent directly to the printer using commands such as lpr. When 
printing with commands, the following items are printed according to [XDW (DocuWorks)] 
settings on the control panel.

Refer to
• “ [XDW (DocuWorks)]” (P. 129)“

Note
• "2 Sided Printing" is displayed when the Duplex unit (optional) is installed. 
• When printing using the lpr command, use the lpr command to specify the number of copies. In such 

cases, the [Quantity] setting on the control panel becomes invalid. If you do not specify the number of 
copies using the lpr command, the printer assumes 1 set. 

The following is an example of printing DocuWorks files from a computer using the lpr 
command. 

Note
• In the following examples, the bold characters are input characters.
• Spaces are indicated with r.

Example

At the command prompt, enter the command as follows.

Example: A command for printing “Report.xdw” when the printer’s IP address is 
192.168.1.100.

• Quantity • Collated

• 2 Sided Printing • Layout

• Print Mode • Output Size

• Password

C:\>lprr-Sr192.168.1.100r-PrlprReport.xdw <Enter> key
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3.12 Printing Using E-mail
 - E-mail Print - 

When the printer has HDD Extension Kit (optional) installed,  and is connected to a network 
environment that allows TCP/IP communication and e-mail receipt, e-mail can be sent from 
a computer to the printer. 

The printer can automatically print e-mails received according to settings by the printer.

This feature is called Mail Print. 

Important
• In case the HDD Extension Kit (optional) fails, we recommend you to back up the HDD Extension Kit 

(optional) data on your computer.

Note
• The following documents are available as an attachment: TIFF, PDF, JPEG (JFIF), XML Paper 

Specification (XPS), XDW (DocuWorks documents) and XBD (DocuWorks binder documents).

Configuring the Mail Print Environment

To use Mail Print, you must configure servers on your network (such as SMTP and POP3 
servers).

Note
• Configuring the wrong e-mail settings can cause network problems. Be sure to leave configuration of e-

mail settings up to your network administrator.

Network Environment Settings

E-mail account creation

E-mail

Printed 
automatically

Printed 
automatically
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E-mail Environment Settings (Printer)

Configure the items described below on the [Properties] tab of CentreWare Internet 
Services.

Note
• After configuring the settings, be sure to click [Apply] and then turn the printer power off and then back 

on again.
• For details on each menu item, refer to the online help for CentreWare Internet Services.

Item Setting Description Available 
Settings

Receiving 
Protocol

SMTP POP3

Description Administrator’s 
E-mail 
Address

Specify the e-mail address of 
the Internet service 
administrator.

Alphanumeric 
characters plus 
ampersand 
(@), period (.), 
hyphen (-), and 
underbar (_); 
up to 128 bytes

 Machine’s 
E-mail 
Address

Specify the printer’s e-mail 
address. This address will 
appear in the “From:” field on 
e-mails sent from the printer.

Connectivity > 
Port Settings

Receive 
E-mail

Select this check box.
-  
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Connectivity > 
Protocols > 
TCP/IP

Host Name Specify the printer’s host 
name. Host name is used by 
dynamic update of DNS and 
SMB. If host name having 
more than 16 single-byte 
characters is set, the first 15 
characters are regarded as 
host name.

Alphanumeric 
characters plus 
hyphen (-); up 
to 32 bytes

 

Domain Name Specify the DNS domain 
name. 

Alphanumeric 
characters plus 
period (.) and 
hyphen (-); up 
to 255 bytes

 -

Obtain DNS 
Server 
Address 
Automatically/
Obtain IPv6 
DNS Server 
Address 
Automatically 

Select the [Enabled] check 
box to obtain the IPv4 DNS 
server address/IPv6 server 
address automatically.

IPv4:
• Cleared: 

Manual
• Selected: 

DHCP*
IPv6:
• Cleared: 

Manual
• Selected: 

DHCPv6-lite

 -

Preferred 
DNS Server/
Alternate DNS 
Server 1 - 2

Specify the IPv4/IPv6 DNS 
server address. 

IPv4: 
xxx.xxx.xxx.xxx
IPv6: IPv6-addr 
format

 -

Dynamic DNS 
Registration 
(IPv4/IPv6)

Select the [Enabled] check 
box to update the IPv4/IPv6 
DNS automatically, and the 
[Overwrite] check box to 
overwrite. 

• Enabled
• Overwrite*

 -

Generate 
Domain 
Search List 
Automatically 

Select the [Enabled] check 
box to generate the domain 
search list automatically. 

• Selected: 
Auto 
generation 
enabled*

• Cleared: 
Auto 
generation 
disabled 

 -

Domain Name 
1 - 3

Specify domain names. Alphanumeric 
characters plus 
period (.) and 
hyphen (-); up 
to 255 bytes

 -

Connection 
Time-Out

Specify the time-out time for 
domain searches. 

1 - 60 seconds
1 second*  -

DNS 
Resolution via 
IPv6 First

Select the [Enabled] check 
box to give priority to IPv6 
DNS resolution in the dual 
stack mode. 

• Selected: 
Priority*

• Cleared: 
Non-priority

 -

Item Setting Description Available 
Settings

Receiving 
Protocol

SMTP POP3
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Services > 
E-mail > 
Defaults > 
From 
Address > 
Edit

Receiving 
Protocol

Specify the e-mail receiving 
protocol. 

• SMTP
• POP3*

 -

Incoming 
E-mail Print 
Options

Configure this setting when 
printing the e-mail header 
and message along with the 
document attached to 
received e-mail. Specify 
[Attachment, Full Headers & 
Message] to print the receive 
routing of the e-mail, etc. 

• Print 
Attachment 
Only

• Print 
Attachment 
& Message if 
it exists

• Attachment, 
Basic 
Headers & 
Message*

• Attachment, 
Full Headers 
& Message

 

Print Delivery 
Confirmation 
E-mail

Specify whether or not 
delivery receipt e-mail 
should be printed.

• Off*
• On
• Print when 

delivery fails

 

Connectivity > 
Protocols > 
POP3 Setup

IP Address / 
Host Name & 
Port

Specify the IP address of the 
POP3 server for receiving e-
mail, the IPv6-addr format, 
or FQDN (Fully Qualified 
Domain Name). 
Specify the port number 
used by the POP3 server.

Alphanumeric 
characters plus 
period (.) and 
hyphen (-); up 
to 128 bytes
1 ~ 65535

- 

POP Receive 
Password 
Encryption

Select the [APOP 
Authentication] check box to 
use APOP for POP receive 
verification. 

• Cleared: 
Disabled*

• Selected: 
Enabled

- 

Login Name Set the login user name for the 
POP3 server. Only one user 
can be specified. 

ASCII graphic 
characters 
(codes 33 to 
126); up to 64 
bytes

- 

Password Specify the password for the 
POP user name, and re-enter 
the same password into 
[Retype Password].

ASCII printable 
characters 
(ASCII graphic 
characters plus 
space; codes 
32 to 126); up 
to 64 bytes

- -

Polling 
Interval

Specify the interval for 
polling the POP3 server for 
mail. 

1 to 120 
minutes
10 minutes*

- 

Item Setting Description Available 
Settings

Receiving 
Protocol

SMTP POP3
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Connectivity > 
Protocols > 
SMTP Server

SMTP Server 
IP Address / 
Host Name

Specify the IP address of the 
POP3 server for receiving e-
mail, the IPv6-addr format, 
or FQDN (Fully Qualified 
Domain Name). 
Also specify the port number 
used by the SMTP server.
• IPv4

Input data in the form of 
xxx.xxx.xxx.xxx. xxx 
indicates numeric values 
between 0 and 255.

• IPv6 
Input data in the form of 
xxxx:xxxx:xxxx:xxxx:xxxx:
xxxx:xxxx:xxxx. xxxx 
indicates values in 
hexadecimal.

• When inputting the wrong 
data, re-enter it by 
pressing <Clear>button.

Alphanumeric 
characters plus 
period (.) and 
hyphen (-); up 
to 128 bytes

 -

Port Number 
for sending E-
mail

Specify the port number 
used by the SMTP server for 
sending e-mail.

1 ~ 65535
 

Port Number 
for receiving 
E-mail

Specify the port number 
used by the SMTP server for 
receiving e-mail.

1 ~ 65535
 -

SSL/TLS 
Communication

Specify the SSL/TLS 
communication for SMTP. 

•Disabled*
•STARTTLS
 (If Available)
•STARTTLS
•SSL/TLS

 

Machine’s E-
mail Address

Specify the printer’s e-mail 
address.
Any name can be specified 
for the account (Left side of 
@ mark) in case of SMTP 
reception. Specify combined 
values of the host name and 
domain name for the 
address (Right side of @ 
mark). Alias cannot be 
specified.
• Account Name: mymail
• Host Name: myhost
• Domain Name: 

example.com
E-mail address for the above 
example is 
mymail@myhost.example.com.

Characters 
allowed for e-
mail 
addresses; up 
to 128 bytes

 -

Login 
Credentials 
for the 
Machine to 
access the 
SMTP Server 
to send 
automated e-
mails

Specify the authentication 
method for the SMTP server.

• None*
• POP before 

SMTP
• SMTP AUTH

 -

Item Setting Description Available 
Settings

Receiving 
Protocol

SMTP POP3
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Receiving E-mails

Supported E-mail Attachments

The printer can receive e-mail attachments in the following formats.

• PDF files (Created with Adobe Acrobat 4 to Acrobat 9. However, when using PDF Bridge, 
some features added from PDF 1.5 and later are not supported. When using PostScript, 
some features added from PDF 1.7 and later are not supported.)

• TIFF files

• XML Paper Specification (XPS) files

• JPEG (JFIF) files

• DocuWorks files

Receiving E-mails

This example shows how to use Outlook Express to receive e-mail from a computer to the 
printer.

1. Use your e-mail software to create the e-mail and attach any XML Paper Specification 
(XPS) file. 

Note
• E-mail messages in text or HTML format are supported. For e-mail messages in HTML format, the 

printer prints only text part of the message. If text part of the message is not sent despite its format is in 
HTML, the printer does not print e-mail message.

• The printer may not be able to print the attached file properly if its extension is other than tif, tiff, pdf, 
jpeg, jpg, jpe, jfif, xps, xdw or xbd.

• If the extension of the attached file is txt, “text/plain“ is specified for Content-Type. It is printed only when 
“us-ascii“ or “iso-2022-jp“ is specified for charset.

• There is no case sensitivity in extensions of the attached files.
• Attachment of up to 31 documents is supported. 

However, if the attachment cannot be printed by the printer due to its format, it is not counted as the 
number of attachments.

2. Enter the printer’s e-mail address for the address. 

3. Send the e-mail. 

Connectivity > 
Protocols > 
SMTP Server

Login Name Specify the user name for 
authentication for an SMTP 
server that requires 
authentication. 

ASCII graphic 
characters 
(codes 33 to 
126); up to 64 
bytes

 -

Password Specify the login for the 
SMTP server.

ASCII printable 
characters 
(ASCII graphic 
characters plus 
space; codes 
32 to 126); up 
to 64 bytes

 -

Item Setting Description Available 
Settings

Receiving 
Protocol

SMTP POP3
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Note
• E-mail messages and attached documents are printed in accordance with the following settings on the 

receiving printer. 
• Mail Message: A4-size, one-sided
• TIFF File Attachment: current [TIFF/JPEG] setting for [Memory Settings] under the CentreWare 

Internet Services [Language Emulations] setting 
• PDF File Attachment: [PDF] when [PDF Bridge] is selected for [PDF] > [Process Mode] on the control 

panel; current [PostScript] setting for [Memory Settings] under CentreWare Internet Services 
[Language Emulations] when [PS] is selected for [Process Mode]

• XML Paper Specification (XPS) File Attachment: Settings of Print Ticket (operation depends on [XPS] 
settings configured with control panel) included in the XPS

• XDW or XBD File Attachment: [XDW (DocuWorks)] settings configured with control panel

Receiving and Printing E-mail Manually 

Though e-mail is printed automatically when it is received by the printer, it also can be 
printed manually from the control panel (Only when POP reception). 

Note
• This feature is available if HDD Extension Kit (optional) has been installed while [Properties] > 

[Connectivity] > [Port Settings] > [Receive E-mail] of CentreWare Internet Services is [Enabled] and 
[Properties] > [Services] > [E-mail] > [Receiving Protocol] is set to [POP3].

1. On the control panel, press the <Print 
Menu> button.

Note
• In some environments, [Pte. Charge Print] will appear 

on the display first.

2. Press the < > button until [Mail Print] is 
displayed.

3. Press the < > or <OK> button to select.
A receive start confirmation screen is 
displayed.

4. Press the <OK> button.
This starts reception of the e-mail. The 
message is printed after reception is 
complete. 

The [Ready to print] screen appears 
automatically after printing is complete. 

Print Menu

 Secure Print

Print Menu

 Mail Print

Mail recvd.

Use OK to process

Mail received

Job in queue

Ready to print

 Toner Left 
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Precautions When Using Mail Print 

Security Precautions

E-mail uses the Internet, a network connecting computers around the world, as its 
transmission medium. Because of this, exchanging e-mails involves security risks such as 
information leakage and tampering.

Use of a method that is more secure than e-mail is recommended whenever exchanging 
important or confidential information. To prevent unwanted e-mails, do not give out your e-
mail address unless necessary.

Setting IP Filter by Domains

The printer can be programmed to receive e-mails only from particular domains.

For more information on setting IP Filter by domains, refer to the online help for CentreWare 
Internet Services.

Precautions When Connecting the Printer with an Internet Provider

• If your Internet provider does not bill you at a flat rate, or if you do not have full-time 
access to the Internet, you will be charged every time the printer retrieves data from the 
e-mail server.

• Make sure to connect the printer in an IP masked environment. Proper operation is not 
guaranteed when the printer is connected to the Internet with a global IP address 
assigned.

• When enabling POP access, make sure to create a unique e-mail account for the printer. 
Using a shared e-mail account can cause problems.

• It may take time to receive graphics and other large data when Internet speed is slow. 

• Some providers also support SMTP reception. Use of SMTP requires detailed setup with 
your provider. 

• When connecting the printer to an Internet environment where MTA (Mail Transfer Agent) 
is running in a private segment, configure settings according to your operating needs.


